HYGSN

HYCON TECHNOLOGY

HY-Programmer
User’s Manual




HYGON

)
HY-Programmer User’s Manual HYCON TECHNOLOGY
Table of Contents
1. PROGRAMMING WINDOW ... ...t e e e e e aaaas 3
1.1 INTERFACE SETUP ...ttt e oo oo e e et e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e aaaaaaaaaaaaaaaaaaaans 3
1.2 OPERATION PROCEDURES.......uutttttttttttttasusutssasasasasssasssnsasasssasssssassssssssssss s s s as 6
1.2.1  Open File and ASSEMDIY ...t bbbt 7
1.2.2 Download Hex File to Programmer or IDE FIash MEMOrY ........c.cccoiiiiiiiniieiineneee e 9
1.2.3 Read the Code from FIash MEMOIY ... 10
1.3 PC ONLINE OTP PROGRAMMING ...ccettttttttttttttttetttttetetatttetataeaeeeseeeteeeaeseeeteaeataeassessssssssssssssssssssssssssnnns 11
O
1.3.1 Blank Check R e 12
Oy
0 (0T = o TSR 12
I
TG T0C T V£ 1 Y PSSR 13
ik
1.3 REAU ™ bR h e R R R R R R R bR Rt bR AR b sttt ne e 13
135 AUTO # ................................................................................................................................................. 14
1.4 OFFLINE PROGRAMMING ....tttttttttttttatatatatsssassssssssssssssssssssssss s s s 15
1.4.1  Program DESCIPHION .....cc.iiiiiieiieieie ettt e bbbttt se et b e sbesb e st e bt bt e neaneeebeabesbesbesbesneeneas 15
1.4.2  Program TiMES RESIICHON. ......c.iiiiiiie ittt bbbt b et be b et b sbesneeneas 17
1.5 INFORMATION BUTTON ..ot e e e e e e e e e e e e e e e e e e e e e e e e e aaaaaans 18
1.6 ERROR IMESSAGE ....ccittiiiiiiiiiiititieit ittt ettt et ettt ettt et ettt ettt et ettt sttt ettt ettt eese et et ee e e as e s s e ssssssesssesseesesesssnsnnssnnnnns 20
2. REVISION HISTORY ... et e e eaaas 21
© 2008-2012 HYCON Technology Corp APD-HYIDE004-VO5_EN

www.hycontek.com page 2



HYGON

HYCON TECHNOLOGY

HY-Programmer User’s Manual

1. Programming Window

1.1 Interface Setup

Click “Options” , a window will appear. Click the interface setup, as shown in Figure 1.

E@E HYIDE - Mode:[Edit] ¥2.80 Chip = HY - 11F13 (4K} ICE Inteface = USB Project =

File Edit Seaxch View Programomer Optons Wmdows Revision History
' N

10
oL

Click [Optians] + “

’E#E Interface Setup

I
+
Interface Setup+ Interface Setup Build Options

Int Setup ICE Test
Register 0SC Calibration
IR TSNS -+ select chipe
Language IEninsh v}ﬁ__ |
Haidwate Interface | Select Language+ |

& |rterface Mode

use = USE Interfaces |

IDE Mode
" emulste and Debug
|| Select
& Programmer4——— Frogrammer+

Program Mermony Select

| RAM 62256 =

Ehss‘

Figure 1
Chip Select > Choose the specific programming IC part no. If programmed IC differs from the

selected IC, Blank Check, Program and Verify will fail.

Language - Choose operation interface language, like Chinese or English.
Hardware Interface > USB interface or Parallel Port interface is selectable.
IDE Mode - Program choosing.

When interface setup finished, click “Build Options” to select programming configuration. As
described in Figure 2.
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]E'E Interface Setup

Generate Files

Stack Option |——P>

Enable Program
Times

Interface Setup Build Options
Int Setup ICE Test
Register OSC Calibration

Generate Files W Enable Tool Bar
¥ Hex file Font [
[ obj file No Use Area Fill
I List file « Qo
[~ ASCII fie ® I

SRR Proaramiey func. settings
I~ f* Blank OM

" Blank OFF

ACH Vaoltage

5 ACH I

" ACH I

_ [v Program Protect

Stack Option Compiler Select

[v Stack Over resel ~

Iv Stack over STOP o~

Input Program Times

|8 [ Enablz Program Times

Close

Build Option

No Use Area Fill
00 or FF

Program Key
Function Setting-
Choose Blank
Function is On or Off

Figure 1

Generate Files &> Choose generated file after assembly

Smart Compiler

Program Protect

Input Program
Times

Stack Option > Choose whether to reset when stack overflow or stack full after OTP program

operation.

No Use Area Fill > Fill up 00 or FF in unused program space after assembly.

ProgramKey Func. Settings = Choose blank function is on or off when using program key

Smart Compiler >

under offline programming.

Choose whether to simplify assembly.

Enable Program Times - Choose whether to enable download program times.

Input Program Times - Input download program times (Maximum: 2147483646. Minimum: 1).

After assembly finished, click “ICE Test” to evaluate test voltage as Figure 3 described (Connect

IDE and insert 9V power before clicking “Option”).

© 2008-2012 HYCON Technology Corp
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Interface Setup Build Options
Int Setup ICE Test
Reqgist 0SC Calibrati
eqgister alibration Show VPP
SRAM Data Voltage
Address VPP /
Write Data “v/
Hzsdlelz Check VPP«
Wit | Fead |
\als Show W CC
Program ROM Data _— Yoltage+
Addreszs |
Wiike: Data e L
Read Data [~ Check vcee
wite | Read | CK ALL
| Check “PP and VCCv
Cloze |
Figure 2

VPP voltage while programming: 5.6<VPP<6.6.

VDD voltage while programming: 2.7<VPP<3.6.

Click "OSC Calibration” for starting Software/Hardware Calibration. Please note this function

only can work on the programmer "HY10000-WKO05” with the software, HYCON-IDE V.3.0 and

future updated version.

Finally, click “Close” after the interface setup is done. All configured arguments will be recorded.

If the configuration is opened next time, default value will be written in automatically and the selected

programming IC part no. will be shown in topic window as Figure 4 described.

Tt HYIDE - Mode:[Edit] ¥2.80

File Edit Search Yiew

10§
011

Chip = HY - 11P13 (4K)

Dptions

ICE Inteface = USB Froject =
Windows Eevison History

L

© 2008-2012 HYCON Technology Corp
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proceeded to Program.

Figure 3
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1.2 Operation Procedures

Open Compiler
Main File

Down Load Hex
File To
Programmer’ s

&3 HyIDEL00 - Mode:[Edit] v1.08

CN Edit Search  View

» Cpenid)

Cpen Praject
Bave Project

Cl+O

Flash Memory

Read Programmer’ s
Flash Memory
(Only For Writer Version)

DT T T Iaett P ey

/ead Frova Flash Memorny

Euit()

CHrl+Q

Chip=HY - 11F13 (4K) ICE Inteface = USB Project =
Programmer Options  Windows
(£ S e Y -

Figure 4

Open > Open the programmed source code main file.

Open Project > Open the saved project.

Save Project > Save the finished project.

*Note: The original “Download file to Flash Memory” function has been cancelled.
HYCON-IDE 3.0 no longer supports Hex File download function. If users would like to

© 2008-2012 HYCON Technology Corp
www.hycontek.com

download the Hex File, please download it by HY-Hex Loader software and follow
the guidance of user manual.
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1.2.10pen File and Assembly

SE)[DE[ED Mode:[Edit] v1.08 Chip = HY - 11P13 (4K) ICE Inteface = OSE Project =
File Edit Ssamch View 1 Progmmmer Ophons Windows

)

W ¢ = gy X oy O Dy

Mainine |KitchForl P13

e

*

.
¥

i

SPICHT : HUE|SPIIRIE

SPICNT =0 == SPIBUF&YBit7=15& , SPIBUFAYB17 =08
SPICNT = | == SPIBUF = $§ERAM Address 7 Low byte --= FSROL
SPICNT =2 => SPIBUF = }§ERAM Address &) High byte --> FSROH
SPICNT = 2 => % {EFRAM Address #EITERERIE

; SPICNTAS Ol B 255
; BCS PIN B 18%0 2 gHO¥E 1 S8R SPICNT

org 0000k

jmp FroBegin
nop
jmp 0

org 0004k

Include Interruptasm

¥
ProBegin:
include  Syslniasm

mvl QEOh
mvf SPIINDEXL,F,ACCE

i | BN TR

mvl  13h  ; FEREIEE
mvf  OFSh,F.ACCE

. . mvl  1h : &5
Display Main . e .,,,f »
Program File | $ X
RN Moduied
E:\CYPRESSVIDELCM\Application) OnlyADCh Testl4\OnlyADCL4. hex |_ Checksum = 0x2546

Figure 5

Open source code main file and it will be displayed as the assembly file. If the displayed name differs

from main file, points the mouse to the specific file and presses mouse right key. Set this file as the

assembly main file as shown in Figure 7.

© 2008-2012 HYCON Technology Corp
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Mainine KitchForl1P13.asm ]

L A

13

s SPICNT : #BISPIRTBIE

: SPICNT =0 == SPIBEUFAYBIt T =158, SFIBUFHIEBL T =08
: SPICNT = 1 == SPIBUF = }8TERAM Address BT Low byte --> FSROL L
: SPICNT =2 == SPIBUF =38FRAM Address &7 High byte --> FSROH

: SPICNT = 2 => #f }&TFRAM Address SETEEEE

: SPICN T/~ A 838 255

s BCS PIN A1850 2 H0gg1 &&0F SPICHT

org 0000
imp  FProBegin
nop
mp 0
org  0004h
Include Interrupt.asm

Click Mouse Right Key.

FroBegin: Set Program Main File
mclude Swslntasm file: KitchForl 1P13 asm
; file: Main ino
mvl OEOh ot Boolomark ,
mvf  SPIINDEXL,FACCE ae:m ;Dmmk R
— AITEE ¢
mvl 13k Al Close file Ct+F4
mvi  OF5h,F,ACCE E
il I E v
< | 14
1:1 Todified
Figure 6

Assembles Source Code and download the file to programmer or IDE Flash Memory, as Figure

8 illustrated.

%3 HyIDEL0D - Mode:[Edit] v1.08 Chip = HY - 11P13 (4K} ICE Inteface = USB Project =

Assemble and Download

File Edit Search View Progremmer Options  Windows to IDE Flash Memory

£ i

[ 011

BOK Cancel

Figure 8

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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Successful downloaded to
programmer or IDE Flash Memory

C:A\Program Files\HylDEYHyIDE\DemoCodeKitchenScale Represent enable program

Program Times Download OK !l times
Program Times Function Enable ***** Program Times = 100 Display this program’s

programmable times

Figure 9
1. When using USB interface, the assembly finished program code will be loaded into programmer or

Flash Memory of IDE for mass production programming.

2. Before downloading code to programmer Flash Memory, system may require to enter into
password. This function enables users to monitor the code from PC to programmer Flash Memory.
Please note that password can only include 6 digits (ASCII Code). In order to protect the code that
users developed, the password must be entered before downloading the code into programmer. If
the password entering step is cancelled during downloading procedure, it means that the code will

not be allowable to be read from programmer.

Furthermore, once you set the password, it will be the operating password of the programmer. This
password has to be entered before you read the code. Please memorize your password to ensure

the code can be read in the future.

In addition, every time a new code is downloaded; the programmer will ask you to enter a new

password afresh.

3. If there is enabled program times in the assembly option, information column will display the

programming times as shown in Figure 10.

4. After assembling completed, Hex filename and Checksum will be displayed in underneath section,

as Figure 11 illustrated.

Download To Programmer’ s Display OTP Display Program
Flash Memory Connection Status Checksum

|E:\CYPRESS\IDELCH\TestDemo\TestDemohoard.hex Body S board Checksum = 0xDOCO

Figure 10

1.2.2Download Hex File to Programmer or IDE Flash Memory

HYCON-IDE 3.0 no longer supports Hex File download function. If users would like to
download the Hex File, please download it by HY-Hex Loader software and follow the guidance
of user manual.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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1.2.3Read the Code from Flash Memory

The function of “Read from Flash Memory” helps users to ascertain whether the code of

programmer Flash Memory is the same with Download Code. The Password entered must in

accordance with the Download Password, so the data will be revealed, as Figure 13 shown.

Edit Search View Assemble&Ru

Cul+N
CtlO
Culd

Mewe (203
Openil)
Save (3

Save As
Save Al
Close File
Clozz Al

Open Project
Save Project

Fead From Flash Memory

Exat(Q) / Ctl+Q

BOK

Cancel

10000

© 2008-2012 HYCON Technology Corp
www.hycontek.com

S Program Memory
0

000 T18DC
001 7801
002 66AR
003 6EAB
004 06FF
005 66AR
006 FOES8
007 0603
008 0104
009 FOAF
o0n 96D2
00B T80A
ooc 6ERT
00D B426
00E 665E
00F 6632
010 6675
011 66B6
012 6682
013 0692
014 D098
015 F094
016 6681
017 FORO
018 F652
F3

TFFD
BC26
1CB1
0604
64D4
12AF
D0Oo07
52n9
7801
FOBO
FOF2
66R9
6ERD
8426
662D
66C5
6677
cooo
6683
0698
60BE
6680
6682
6695
FODO

0000
7809
66AB
66ED
1001
6401
F002
52B1
7813
DOD6
DOBO
882B
32AD
0003
o0o0c
0630
cooo
F99D
0602
6682
010F
0695
0605
0692
D097

DOOF
8C26
82D2
0600
66AF
16B0O
DO07
52B0
oooc
FOB1
FOF3
AEB1
0011
DOFD
FO80
666D
F79D
B82B
6684
0603
0709
6681
6683
6680
FOD1

FOFF
DO3B
EERB
66EC
64D5
6400
FO02
52AF
FOD7
86D2
DOB1
982B
3B29
F011
0680
0600
cooo
7801
0010
6683
6422
0697
0602
0695
D098

8226
64D6
7848
66R9
6401
0606
882B
AO2B
DODS
DOAF
64C5
32n7
7801
0617
0606
06FF
98A8
0601
6681
FO9C
0692
0692
060A
D096

D010
FOD4
71809
64EC
1401
16B1
Doo07
3629
0607
T80A
FOF6
52F6
06F0
DOFC
0col
666F
FTAC
T8CA
coo0o
0603
10BA
6682
6684
6681
FOR1l

Figure 11

FOFE
DO3A
92D2
18R9
6680
0600
F002
TFF9
DOD4
84D2
882B
52F3
6929
F012
3629
0600
0C2B
88A8
F612
6684
6695
0603
0603
0696
oco2

D011
FOD5S
26R9
64ED
64D6
AEO1
3629
86D2
FOO1
AZD2
56F2
52F2
7807
DOFF
TFFD
666E
0CF0
0CB6
Doc2
0601
0600
6683
6685
6682
0C93

FOFD
D039
26RA
1CARA
1400
06FF
TFF8
7827
DODS
94D2
56F3
36A9
0D29
FOOF
o0ocC
06FF
06FB
0604
F095
6685
14BB
0602
cooo
0603
0c94

D012
FOD6
26AB
AB2B
66B1
16R9
DOD6
BGD2
FOO1
DOD6
56F6
TFF8
6F2D
DOFE
F100
6670
66B7
6697
Doc3
0010
6696
6684
F652
6683
0C95
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1.3 PC Online OTP Programming

S HyIDE10D - Mode:[Edit] »1.08 Chip =HY - 11P14 (BE) ICE Inteface = 0SB Frojeci=
File Edit Seamch View Programmer OCphons  Windows

o 10
ald i1 ek

| : FERNR

Blank .
Display Hex Code Check Program Verify Read Auto
Figure 12

Figure 13
Blank Check, Programming, Verify and Read Commands can be implemented when the
programmed file being successfully loaded into programmer or IDE Flash Memory. On the contrary

those commands will not be activated if the download failed.

OTP Chip does not

Chip ID Error!! Program Chip ID = 0x0043 - match with the
selected IC

Figure 14

OTP online

E:WCYPRESSY IDELCMY TestDenc' TestDenohoard. asn in board  Checksuw = 0xDOCO

Figure 15

rh:\CYPRESS\ID!-Tenx\HY-PC\IDE‘J.‘BST\1lpls-lzet,esl'.\Kitch?orlll’la.hex SRS Checksun = 0x45AC

Figure 16

Make sure the selected programming IC part number is the same with the OTP part number in
the topic window as Figure 1 described. When programmer executes Blank Check, Programming and
Verify commands, Program will check whether the IC part number and OTP programming part number
are identical. If the part number is different, the data will not be written into OTP and an error message
will be displayed in information column as Figure 16Figure 14described.

If users intend to find out whether the part number is correct before programming, point the
cursor to "IC Connection Status Display” and click the mouse left key. If the selected IC is correct, a

message will show up as Figure 17. If it is incorrect, the message will be displayed as Figure 18. If

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
www.hycontek.com page 11
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“Enable Program Times” has been marked up, the spare program times will display in the message

column as illustrated Figure 19Figure 17.

S Mezsage
Program Times Left 998

Figure 17

1.3.1 Blank Check o

The internal code of Blank ICs that have yet been programmed is OxFFFF. The purpose of
checking the IC is to make sure the OTP address content is OxFFFF.

If the IC selection is correct and the content is empty, a message will appear as

SBM Blank OK

Figure 18

If the IC selection is incorrect or the content is not empty, a message will show up as Figure 21

described.

Figure 19

1.3.2 Program =

The purpose of programming is to write Compiler accomplished program into IC OTP. When
programming is completed and the IC is assembled as finished goods, programmer can operate the

program as users commanded.

Program the downloaded or assembly finished Hex file (displayed at the bottom of the column)
in the selected IC and verify the correctness of the programming content (please refer to Chapter 1.2.1

or 1.2.2 for programming procedures).

If the selected IC is correct and the programming succeeds, message will appear at the
information column as Figure 22 illustrated. If “Enable Program Times” is ticked up, the enable program

times will minus 1 and the program times left will be revealed in the message column.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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Sﬂemge

‘Program Chip OK
Program SBM OK
Verify Chip OK Show Program Times

Verify SBM 0K (If Program Times Function had been Enable)
Program Times Left HHHHHHH?/

Figure 20

If the IC selection is incorrect or the programming fails, a message will show up as Figure 23.

Program Chip Fail

Figure 21

1.3.3 Verify "=

The purpose to verify programming IC is to compare if the program written into IC OTP equals to
the program downloaded to programmer or IDE Flash Memory.

Verify programming IC content consistency with the downloaded or assembled Hex file
(displayed at the bottom of the column). If the IC is protected by program, this verification is ineffective

or the comparison failed.

If IC selection and program verification is success, a message will appear as Figure 24.

Verify Chip OK

|'1.r'erif5r SBM OK

Figure 22

If IC selection is incorrect or the program verification miscarries, a message will pop up as Figure 25.

Verify Chip Fail

|Errur at Dx0000H

Figure 23

O+
1.34 Read ™
The purpose to read the IC is to verify the consistency of OTP Checksum and programmed Hex

file. To read IC content, the procedures are illustrated as Figure 26. Its content will reveal at "Display

Code” window.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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S HyIDE100D - Mode:[Edit] v1.08 Chip = HY - 11714 (BE) ICE Inteface = OSB Project=
File Edit Search View Programmer Option:  Windows

115 10
[ i1

OTP Type

S Program Memory

4
0000

_ " D082 F01? D081 FO010 D000 FO85 DOB3 FOBC DOBO
OTP Chip is 11P14 21 1605 368C TFF8 3A82 3A81 3684 TFE9 000A CB81D
Read Checksum = 0xFFFF 29 TFFD 000C F086 D081 F012 0601 5229 6406 1C01

2B 0601 5229 1601 3685 TFFD 000A 642R 660F 6611
85 CFBl 6483 0708 D022 F08C D080 F010 6483 882B
01 3629 JFFD 700D 000C F086 D081 F012 D084 FO8D
Checksum 0E 000C F086 D0Bl F0l2 D084 FO8D 0601 5229 6406
10 6485 5601 3629 TFFD 368C TFCF 000A 668D D010
10 648D 0708 D022 F0B3 B882B 648D 5606 3629 TFFD
10 D081 F012 3683 7801 000A 3C8D 0000 6684 C806
03 1000 A629 6600 0630 1000 ARE29 6600 000R 668D
80 648D 0C02 3629 TFFD D080 F010 648D 0708 D022
8D 5202 3629 TFFD D080 F010 D081 F012 3683 7801
00E_ |D081 F012 €806 €200 FOE2 D081 F012 C200 FOCE 0603 A605 1A05 0630
00F _[0000 0000 0000 (0000 :0000 0000 0000 0000 0000 0000 0000 0000 0000

Figure 24
135 AUTO ¥

Auto integrates Blank Check, Program and Verify function. If user selects Auto, it will first check

whether the IC is blank, then to program and verify.

After the execution succeeded, a message will be displayed as Figure 27 displayed. If the
option, "Enable Program Times” is ticked up, the program permitted times will reduce 1 and the

program times left will be shown in the message column.

S Message
SBM Blank OK

Program Chip OK

Program SBM OK

Verify Chip OK

Verify SBM OK

Program Times Left 99999997

Figure 25
If any function fails, the whole process will stop and display an error message in the message

column.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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1.4 Offline Programming

1.4.1 Program Description

As the development process evolves to mass-production, the programmer can be used alone

when programming on the production line. It is not necessary to connect the programmer to the PC.

000000 | P3| 3 | THREL
slsTele]
Oo00
P4 LCM
rifcemation
B u'lel::g':rr Error OK
O O ® &
L2 L1
ra
Figure 26

J1 - DC Jack, 9V input.
*Notice: the case is 9V; the core is Ground (VSS).
U6 - USB port, users use this port to connect to PC.
J3 = IDE port, connecting HY-ICE.
P3 = Program PIN output. PIN and OTP is connected.
Output pin from left to right is VSS, VDD, SDO, SDI, SCK and VPP.
P5 - Extend programming port.

Output pin from left to right is Green LED, Red LED, Blank Check Button, and
Programming Button. For detailed connecting circuit, please refer to Figure 29 and the
definition can be referred to Figure 30.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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5 EED
el
EE [hew
L 470
o o o ]
£
© TG g !\ !\
Figure 29
Blank -------- ¢ pmmmmee- RED
Program----5 { i .---- Green
6066
vss.----1 0000
009000
VPP f 1 1§ 1 i vss
PT1.0 --4 : : LI VDD
PT1.1 o2 - PT1.5
Figure 30

L1 - Success message light display, green LED.
L2 = Error message light display, red LED.

S1 - Program button, for offline program operation.
S2 - Blank Check button, for offline operation.

S3 = Information button.

To implement offline operation, Hex file must be firstly downloaded to programmer Flash

Memory.
S2 Button can check if the IC is blank.

S1 Button is programming button. Its procedures are: Blank Check = Program - Verify.
If "Program Protection” of “Assemble Option” is ticked up before downloading data to Flash Memory;,
program protection will be executed after Verify completed. If "Program Protection” is not ticked up, it

will stop after Verify accomplished.

If any failure or error happened during execution procedures, L2 Red LED will be lightened up.

On the contrary, L2 Green LED will be lighted up if success.

APD-HYIDE004-V05_EN
page 16
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*Notice 1: Under offline programming, the programming status can be determined by checking
LCM. If check sum has been shown on LCM and LCM has stop working, the programming
procedure is completed. (This issue has been corrected on HY10000-WKO02B)

*Notice 2: When programming function is implemented, make sure 9V adapter is connected
before connecting USB line. Do not plug out 9V Adapter whist PC operating, or else it may

result in PC crash.

1.4.2 Program Times Restriction

The menu of "Assemble Option” in interface setup has an option of "Enable Program Times” as

described Figure 2. This option restricts the permitted program times of download program.

This is a safety mechanism that restrains the permitted program times, preventing it from

over-programming on the production line.

After ticking up "Enable Program Times”, key in the program times in the column below "Input
Program Times” (maximum is 99999999, minimum is 1). This argument will be written into EEPROM of
the programmer after the compiler programmed file is downloaded to Flash Memory. Afterwards, the
enabled program times will reduce 1 each time when programming completed. If the value reduced to
0, the programming action may not be executed. At this time, an error signal (Red LED) will be lighted

up but Blank Check still operates normally.

© 2008-2012 HYCON Technology Corp APD-HYIDE004-V05_EN
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1.5 Information Button

»  Press Information button, displaying HYCON IDE message

-]
[ |

11

Wait for 'y - . T

LT ormati1on
1second | M= iZ 5T  LifL

B ]—»[hiel-::.-::-me To Use ]

»  Press Information button again, displaying Program Counter Times message

1. If Program Counter Times is enabled.

[:[i"i'!'-'!:!!""!"'!-iii'!'.-i!:!i"i 1 ]—» [F“':-E'“am Es:!!...!i-'ater]

Wait for -
| h
1second (o Fi= I'_-I -I.. =

Wait for
2 seconds

| ™ [l o, o

Fro Sran _LoulbnLer
== l=l=1= == 1~

!.-.E'F..!._- I-'I.- .-Ilzl.-'-"-"'—' |

Program times left

2. If Program Counter Times is disabled.

Wait for | gm, = w
1second (i} 1 E-EI':I =

[I nformation 1 3 ] — [F' rogdram Codnter ]

»  Press Information button again, displaying VDD and VPP voltage.

Display programmer’ s current
/ VDD and VPP voltage

[I nformation 2 @ ] — [u[;.[;. = BZ.00U ]
Wait for - [ PR ra e
1second (%4 F F' = 1 FG . FEL]

»  Press Information button again, OTP ID and Flash stored ID.

[Im’“ﬂr-r-ua'l:.-:i.ﬁﬂ K ]—»W_” [T P Il = G843 ]
ait for — -
1second (Flash ID = HA43

»  Press Information button again, displaying error message.
1. Ifthere is no error message.

[En{'m‘-r-uia‘i;:ialﬁ 3 = ]_> [FFISE:'- T-=-]

Wait for f A= -
1 selcond [y A " ek aHIL I

]
)

Saved in Flash Mimory
Checksum

2. Ifthere is error message.
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e - [ . - [ 4

Information 4 = — » |Ertror 4
waitfor |21 il F3i1l!
1sec0nd e s "=l i1 . 1 L™ I~ - o

7

Display current error message

Press Information button again, displaying if the blank function is enforced when using program
key

>

1. If the blank function is on.

[ : P Key Fun.
Information 5: rogram Key Fun
Wait for ‘B+P+V
1 second
B:blank, P:program, V:verify
2. If the blank function is off.
I : P Key Fun.
Information 5: rogram Key Fun
Wait for E’+V
1 second

P:program, V:verify
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1.6 Error Message

> VDD Error

Error 1
DD = 2. 121

> VPP Error

[EPPDF 2

UPF = 4.52U

> OTPID Error

[EPPDF !
LhirFr 1D ERE

o

!

Al
N—

» Blank Fail

[Ewrnr )
Blank Fail!

» Program Falil

[EPPDF 5

Frodram Fail!l

»  Verify Fall

dlari+g Faill

[EPPDP 5

» Protect Fail

[EPPDP T

Frotect. Fail!

» Program Counter left zero

[EPPDP 2
Fram Counter
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2. Revision History

Major differences are stated thereinafter:

Version Page Revision Summary
V01 ALL First edition
V02 8 Add the description of password.
15-16  Add the description of P5-Extend programming port.
V03 3-5 Update the figures and add the description of "OSC Calibration”.
V04 17-18  Add a note for attention when offline programming.
V05 ALL Add the description of blank check function and related information

Delete the description of downloading hex file to programmer from HYIDE.
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